JAKROO

Design File
Preparation
Guide

A complete guide to preparing, optimizing, and submitting custom sports
apparel design files in Adobe lllustrator using Jakroo Design Templates.

jakroo.com/templates



Choosing What to Design

If you're designing a full kit, you don't need to design every product.

Start with 1-2 base pieces — a jersey and shorts, or a race suit — and submit those. Our team will build out the
rest of your collection to match to other products like gloves and arm warmers. This saves you time and gets
you to a cohesive kit much faster. Don't worry you can still give us instructions of what you want and request

edits if the matching items are not quite what you were looking for.

Design 1-2 base pieces:

We'll take care of the rest.

Design 1 race suit 1 jersey + 1 pair of shorts

Not sure where to start?

Reach out via support chat or email designlab@jakroousa.com — we're happy to help.



Pre-Design Checklist

Run through this before opening Adobe Illustrator.

COLORS

¢ Download and install the JAKROO Color Palette

Available at jakroo.com/templates
e Decide on your color palette

e If you have brand color values, have them ready
JAKROO swatches or Pantone Solid Coated C

ASSETS

¢ Collect your logos and graphics

Vector preferred; raster at 150 DPI minimum at final size. No screenshots or web-pulled images
e Install and download fonts you plan to use

e Note any required copy, graphic element placement & scale

Names, numbers, flags, sponsor logos

DESIGN INTENT

e Reference images or mood board ready

e Placement and scale notes for key elements and sponsor logos



Setting Up the Template

All Jakroo templates are built for Adobe Illustrator. We strongly recommend working exclusively in Illustrator —
other programs may not handle the template correctly. When you open your template, keep all default
settings as-is, then install the JAKROO swatch file and start designing.

A few things to know:
e Work in RGB color mode — our team handles the CMYK conversion before production
e Save frequently in .ai or .eps format. Other formats won't preview correctly in the 3D model

e Don't move or delete the template layers

Bleed Lines, Art Margins, Cautionary Zones & more...

e Bleed lines: are red lines on templates. They show how far your background color or image should extend
at least 0.5" of the garment.

e Cut lines: where the garment gets cut. More of an FYI.

e Art margin: Logos and text should stay at least .25" inside of them.

e Guideline: Use these lines to guide you when placing your artwork.

e Read direction : Use these directional lines to guide you when placing your artwork (especially text).
e Hem line : Typically, thread is stitched along this line. Please avoid placing artwork on this line.

e No art zones: are areas near zippers and elastic that may get distorted, folded, or sewn during production.
Avoid artwork in these zones.
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WARNING Jakroo is not responsible for artwork lost or distorted in cautionary areas.



Colors

Jakroo uses a custom color palette available for download on jakroo.com/templates — it consists of hundreds
of colors calibrated to print consistently across our fabrics and look accurate on screen. Using these swatches
is the best way to get results that match your expectations.

We also support most Pantone Solid Coated colors. Keep in mind that sublimated fabric absorbs light
differently than glossy paper, so colors may appear slightly more muted. Check with your account manager
before building around a specific Pantone C color.

COLORS TO AVOID

e RGB, HEX, or CMYK values — these won't print as they appear on screen
* Any transparency, opacity, or blend modes (darken, screen, overlay, etc.)
e Drop shadows, glows, or blur effects

e Complex gradients

HOW TO INSTALL THE JAKROO COLOR CHART FILE

—

Download the Jakroo color chart from jakroo.com/templates > Download Jakroo colors
In lllustrator, open the Swatches panel (Window > Swatches)
Click the panel menu icon and select Open Swatch Library > Other Library

Locate the .ase file and click Open
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Click any color in the library to add it to your working swatches

e Physical swatch samples of all JAKROO colors are available on request and a free of charge. Email your account

manager to get yours or request one at: jakroo.com > scroll to footer > SUPPORT > Color Chart

JAKROO136cowomm
o 1 1]
SEEEE
20 SEEes
SBEET 888
B OEEEEs
SBEEEEENS
111
1111
a8 ©
SNEEEees
BT0EEEES
|
SENEEEEE
ST EEEEs
If you are at all concerned with how JAKROO's Colors will look in person = . . = . . .
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Vector vs. Raster

4 Vector — Preferred format for logos & graphic elements

SVG, Al, or PDF

Stays crisp at any size. Can be recolored and edited by our team. If sourcing

logos from a sponsor, request vector files — most companies have them.

Formats: .ai, .eps, .pdf

Raster — Use with caution

JPEG, PNG, TIFF

Made of pixels — can blur when scaled. Cannot always be recolored nor

edited by our team.

Acceptable only if: 150 DPI minimum at final size, with a transparent
background (PNG or TIFF preferred).

NOTE Saving a raster image with a vector extension (.ai, .eps) does not make it vector.

HOW TO VERIFY YOUR FILE IS ACTUALLY VECTOR

e Zoom in past 400% — crisp edges = vector, pixelation = raster
e In lllustrator, use Outline View (Cmd/Ctrl+Y) to check for vector paths

e Not sure? Email customdesign@jakroousa.com before building your design around it



Al-Generated Images & Copyright

Al-GENERATED IMAGES

Al-generated images (Midjourney, ChatGPT, Gemini, Firefly, etc.) are raster by default and often exported at 72
DPI — far below what we need for print.

If you want to use Al-generated artwork, look for a tool that exports SVG or vector files. Our team is not

responsible for Al-generated images that print incorrectly.

TIP Always check resolution, file dimensions, and background transparency before building your design around an Al

asset. Questions? Email customdesign@jakroousa.com.

COPYRIGHT & TRADEMARK

You are responsible for having permission to use any logos, graphics, or imagery in your design. Jakroo will

ask for proof of approval for any third-party brand or company logo.

There are some graphics we cannot print regardless of permission — including competitor sportswear brands,

sports team emblems, and TV, film, or music IP.

NOTE All submitted artwork is reviewed before production. We reserve the right to request changes or decline an order if

content doesn't meet our guidelines.



Minimum Sizes & Special Effects

Our fabric is porous, which means small or highly detailed graphics can lose sharpness in print. Keep it simple
if you're going small.

MINIMUM GRAPHIC SIZES

Icons 1.5" minimum
Logos with text 2x3" minimum (credit card size)
Complex logos 4" minimum

STROKES & OUTLINES

Any stroke (outline around a graphic or text) must be at least 1.5pt thick. Thinner strokes may disappear or
bleed in print.

SPECIAL EFFECTS

Avoid entirely: Drop shadows, glowing edges, Gaussian blur

Use sparingly: Gradients, textures, photographic elements

NOTE |f your design includes small or detailed graphics, order a test print before your full run. Our team may need to

scale artwork up — what looks right on screen may come out larger than expected.



Saving Your Final Design

BEFORE YOU SAVE YOUR FINAL DESIGN FILE

0 Outline all text

Type > Create Outlines, or Shift+Cmd+O (Mac) / Shift+Ctrl+O (Windows)

e Embed all images

Window > Links > select image > Embed Image

e Toggle ‘Art Margins’ and ‘Cut Lines’ layer visibility off in Illustrator layer panel
While it will not affect the printed garment, leaving these layers visible will cause the preview to show
unwanted guidelines.

° Save as .ai or .pdf

Other formats won't preview correctly in the 3D model

PRE-SUBMISSION CHECKLIST

Text outlined

All logos are vector or meet raster requirements

All colors map to JAKROO120 or approved Pantone C swatches
Graphics meet minimum size requirements

All strokes at 1.5pt or thicker

Foreground art stays within art margin lines

Background art extends 0.5" beyond bleed lines

00000000

Art Margins and Cut Lines layers are toggled off



Previewing & Submitting Your Design

SUBMITTING

Go to jakroo.com/templates and click "Submit Your Design." You can select up to 4
additional products for our team to match to your design.

Journal Athletes Reviews ) & ALFREDO | MY ACCO

EVO Collection Custom Products How it Works Find Your Team Store ) START YOUR DESIGN

DESIGN TEMPLATE DOWNLOADS

START HERE (@ Pro-Tip: Start with the basics! Design a top & shorts or a suit

Download Design Resources
9 You don't need to create individual designs for each product; our team can

Everything you need before opening a template - Design guide, best practices, create matching items from your design!

|

print specs, and our calibrated fabric color palette.

.\, Design Guide ., Jakroo Colors

Sort by A-Z

AERIS ALASKA ALPHA APEX 2.0 ARC 2.0 ARENDAL
Packable Vest Softshell Jacket Aero Jersey Run Singlet Women's Run Singlet Warm-Up Jacket
!, Downlocad Templates !, Download Templates !, Download Templates !, Download Templates !, Download Templates !, Download Templates

Preview your artwork on the 3D model before submitting it to our design team. Feel free to
make changes and preview again as many times as you need until you're satisfied.

& PRODESIGN

Preview & Design Template Brand Assets ) Design Notes ) Design Profile ) Review Request

Preview & Design Template Skip for now

Upload your design to preview it on the 3D model. Swap files as many times as you need before saving

2 2D View =} Download 3D Images
@ Pro-tip: You don't need to create designs for every

product. Our team will contact you to create matching
items from your submitted artwork.

Product: ALPHA ()

+ Upload your design file

Configure your Design

[
Front Hidden Zipper @

Artwork not displaying correctly or failing to upload?
Please start a support chat so we can take a look at
your file to make sure everything is formatted correctly.

View best practices for using our Design Templates.

WHAT HAPPENS NEXT

After you submit, our design team will promptly begin working on your final production-ready mockup. You
can expect it to be ready within 2 to 4 days in the Approval Center, where you will have the opportunity to
approve it, request edits, or inquire about matching items.



Test Prints

A test print lets you catch issues — sizing, color, detail loss — before committing to a full order. It's a small
investment that can save a lot of frustration.

We provide two options for test prints:

1. Physical Test Prints: We will mail you a large-format fabric test print featuring one or more of your designs.
This option takes 10 days to arrive and costs $11, plus shipping.

2. Photo Test Prints: You will receive a high-resolution photo of your test print. This option is quicker, taking just
3 days, and also costs $11.

Order a Photo Test Print if your design includes any of the following:

e Small or complex graphics

e Raster images

e Al-generated artwork

e Gradients, textures, or photographic elements

e Strokes/outlines thinner than 2pt

Order a Physical Test Print if:

e Make sure printed colors match your expectations, especially those outside the JAKROO palette.

e Using low contrast between colors. e.g. background and foreground are similar shades

To order a test print, simply reach out to your account

manager or mention it in your submission form. Designers

TI-600-€90T1-TA[

may spot potential issues in your design and might
suggest or require a test print before moving forward.

Not sure if your design needs a test print?

When in doubt, print it. Our team can help you decide — email designlab@jakroousa.com or start a support chat.



Questions?

We're here to help.

Email
Email your account manager or write to designlab@jakroousa.com

For design questions, template assistance, color swatch requests, file verification, vector inquiries, and
production guidance, please reach out.

Phone or support chat

1.800.485.7067
Monday to Friday, 9 AM to 6 PM Central Time.

jakroo.com/templates



